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En este documento se va a explicar como crear un proyecto en KiCad, el resultado final sera
una réplica de la tira de LEDs de abierto.cc
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1. Esquema

Abrir KiCad y crear nuevo proyecto.

File Browse
Open Project cerl
Open Recent

~ New Project

New Project from Template Cerl+T

Archive Wald
e = e ——— - gk ool -~
Unarchive F—— —
|Project name:
Close ctrl+Q @ |/home/jose/Escritorio/Proyectos/guitarra/guitarra/KiCad/instronics_shield.pro

| ﬁ instronics_shield.net
.:Hf instronics_shield.sch
[:ﬁ instronics_shield-cact

[]:] instronics_shield-resg

A continuacién tendremos que elegir un nombre para el proyecto y un lugar donde va a ser
guardado.
Una vez hayamos hecho esto, automaticamente KiCad crea un archivo para la creacién del
esquema del circuito que queremos fabricar, de extension “.sch” y otro de en el que vamos a
crear el diseno del PCB, de extensién “.kicad_pcb”. Ambos cuelgan de un archivo “.pro”
El primer paso es crear el esquema del circuito vamos a fabricar, por lo que vamos a empezar
por modificar el archivo de extensién .sch.

Y

Para ello, tenemos que abrir Eescheema. |——— |

File Browse Preferences Tools Help

' IET‘ tiras.kcadjcb :?Ei . _

Igf tira_LEDs.sch

) B &

I edy] Eeschema - Electronic schematic editor
/home/jose/Escritorio/tutorial/tira_LEDs.pro

Sujeto a la licencia Reconocimiento-NoComercial-Compartirlgual 4.0 Internacional de Creative Commons



https://creativecommons.org/licenses/by-sa/4.0/

En este momento, el primer paso es darle un nombre a nuestro esquema y seleccionar un
tamano de pagina, para ello vamos a File -> Page Settings y fijamos el tamano de la hoja a A4
y le damos un titulo al esquema: LEDs Strip.

Page Settings

Paper Title Block Parameters
Size: Number of sheets: 1 Sheet number: 1
| A4 210x297mm + | IssueDate
R ' <<<| (20/01/17 v | [] Export to other sheets
Orientation: 3 : =
Z Revision
Landscape = =
—~ - [ ] Export to other sheets
Custom Size: Title .
Height: width: |LEDs Strip | [ Exportto other sheets
Company
Layout Preview abierto.cq ["] Export to other sheets
Comment1
["] Export to other sheets
Comment2
["] Export to other sheets
Comment3
| [T Export to other sheets
Comment4
; ["] Export to other sheets
Page layout description file
Browse
Cancelar | Aceptar '

Colocado de componentes

Una vez hecho esto, vamos a empezar a colocar los componentes, para este proyecto se
necesitan:

e 8LEDes

e 1 Tirade 9 pines

e 2 Array de resistencias
Para seleccionar el componente que queremos utilizar debemos seleccionar la opcidon Place
Component, en la parte derecha de la pantalla.
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Place component

e

A continuacion hacer clic en cualquier lugar de la hoja del esquema y saldra un menu donde
buscar los componentes

Choose Component (3179 items loaded)

Filter: “ ‘

T4xx

adc-dac

analog switches
atmel

audio

cmos4000

conn

contrib

cypress

¥ ¥ ¥ ¥ ¥F ¥V ¥ ¥ ¥

Cancelar | | Aceptar
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En este menu buscaremos:

LED para encontrar los LED que necesitamos y seleccionaremos la opcién LED [LED
Generic]

Conn para buscar la tira de pines y seleccionaremos la opcion CONN_01x09
[Connector, Single row, 1x09]

Algunas de las acciones mas comunes que se pueden hacer con los componentes son:

Mover (Letra M) : Cambiar la posicion de un componente que ya habia sido colocado.
Copiar (Letra C): Copiar componente.

Editar Referencia (Letra U): Cambiar la referencia que asigna al componente.

Editar Valor (Letra V): Cambia el valor del componente.

Footprint (Letra F): Asignar o cambiar el footprint del componente.

Editar Componente (Letra E): Menu en el que aparecen todas las cosas editables del
componente.

Rotar (Letra R): Girar componente.

Mirror X (Letra X): Girar el componente en forma de espejo en el eje X

Mirror Y (Letra Y): Girar el componente en forma de espejo en el eje Y

o Choose Component (3537 items loaded)

Filter: [LED| |

v device

LED [ LED generic ]
LED_ALT [ LED generic, alternativ symbg
LED_ARGB [ LED RGB, common anode (pin 1)
LED_CRGB [ LED RGB, Common Cathode ]
LED Dual 2pin [ LED dual, 2pin version ]
LED Dual AAC [ LED dual, commen cathode ]
LED Dual AACC [ LED dual, 4-pin ]
LED Dual ACA [ LED dual, common cathede ]

LED

D Description

LG 2o e
W Ep

Cancelar Aceptar
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o Choose Component (3538 items loaded)

Filter: |conn
CUNN_UIAUS TIRLL [ UENETIC FELE CONTECLUT, SINYU
CONN_01Xe4 [ Connector, single row, 01)(045
CONN_01X04 FEMALE [ Generic Female Connector, S
CONN_01X04 MALE [ Generic Male Connector, singl

single row, 01x08,

‘Connector, single

I%' I%' CONN_01X09 I%'
= ¢
Ll
—l
™

E | CONN_01X05 [ Connector, single row, @1x@5,

i CONN_01X06 [ Connector, single row, 01x66,

A CONN_01Xe7 [ Connector, single row, 01x07,
R CONN_01xe8 [ Connector,

~n. O ) .. O ~.
o - L 2 De;:ription' : Lol - .
: e Connector, single row, ] D_
4 2 01x09, pin header
oN 51 |3 o~
6 |2 Keywords
|5 connector
S

F
9

Cancelar Aceptar

Una vez seleccionados los componentes que necesitamos, los tenemos que colocar en la
pagina construyendo el esquema de conexiones, el resultado debe ser similar al mostrado a
continuacion:

A eaacRE BEE LK i 2
S o 5]
I3 &
[z I
& R 8 B & B 5 & = +
o N N N N N N N N s
|I\ =) A0 A, O A, O A, O ~. O A, O A, O ~. y
Lot Lt Lt 4] Lt Lot Lt 9]
o~ & o~ o~ o~ o~ o~ o~
X
_"
A
lan]
O O] I~ WO W T M N e
~. 5
= ba)
T
Reference  Value Component Library  Footprint Description KeyWords
J? CONN 01X09  CONN 01X09  conn <Unknown>  Connector, single row, 01x09, pin header  connector
File /home/jose/Escritorio/tutorial/tira_LEDs.sch saved 7550  X54,60 Y 74,30 dx 54,60 dy 74,30 dist 92,20 mm

El componente que nos queda por colocar no tiene un footprint en las librerias de KiCad, para
utilizarlo existen dos opciones:
1. Utilizar el footprint de un conector de 5 pines, ya que el pitch (distancia entre pines) del
array de resistencias que vamos a usar y el del conector es el mismo.
2. Crear el componente.
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Crear nuevos componentes

En nuestro caso, vamos a crear el componente. Para ello vamos a utilizar el library editor Ez]
en la parte superior de la pantalla.

Ly =1 Aol aacR B [PIEH £ D m 4o
i oo componen) 5
Y =
o =
& £
i SAS a 6. a 6. a 6. a a a a o |7
- D_I [ _I = _I [ _I _I _I _I =]
K
X
2
LAy
D
O O] I~ Wl WO ~F| M| N g
. '
A=y DA
CONN_01X09
T

Una vez dentro del library editor vamos a seleccionar la opcion: “Create a New Component”

D . Al seleccionarla, nos aparecera una ventana en la que le asignaremos a nuestro
componente el nombre “ResistorArray” y pulsaremos “Aceptar”.
Al hacer esto, en el editor de componentes aparecen el nombre del componentes y la

referencia: U?.

A continuacién vamos a crear el componente, en primer lugar, vamos a colocar los terminales.
. A
“ . ” 1
Para ello, pulsamos en “Add pins to component

Va6 s o ET I QAR 3=

=
mm| Add pins to componer
|53

% 7

-

-
)

AJ
Q)]
wm
m

rA
A

m G
J
ao‘&UJQD

P
L

De esta forma vamos a afiadir los 5 terminales que necesita nuestra red de resistencias, vamos
a etiquetar cada terminal con la siguiente nomenclatura:
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Nombre Numero

GND 1

R1 2

R2 3

R3 4

R4 5
Pin name: GND Name text size: 1,270 millimeters
pinnumber: (1 | Numbertextsize: (1,270 millimeters
Orientation: | Right B ks 5080 millpsters

Electrical kype: | S{Input

Graphicstyle: ||-Line

Sharing 1
(] commontoallunitsin G N D

[ common toall body styles (DeMorgan)

Una vez que hemos colocado todos los terminales, vamos a darle forma al componente, esto lo
vamos a hacer pulsando en la opcion “Add lines and polygons to component body” del menu de

la derecha :1 .

rArray

Schematic Properties
& visible

|
Canceler | | Aceptar | »

st%

_ U?

o L GND
I —21R1

5 13 R2

E’ 4

O —2 1 Ry

(0
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Con la herramienta de lineas seleccionada, vamos a fijar un punto de inicio y haciendo clic con
el botdn izquierdo haremos las esquinas del componentes. Para finalizar la forma del
componente, haremos doble clic con el botdn izquierdo.

Antes de guardar, vamos a afiadir al componente una descripcion, para hacerlo, nos vamos a

BC
“Edit component properties” ﬁ“\'} en la barra de herramientas superior y anadimos el siguiente
texto:

(] Properties fFor ResistorArray

Options | Description | Alias | Footprint Filter

Description
Red de resistencias conterminal comin

Keywords
|Resistor]

Documentation File Name

Copy Document from Parent | |Browse Files

Cancelar | | Aceptar |
Para guardar el nuevo componente, creamos una carpeta de nombre “componentes” en la
carpeta contenedora del proyecto. Una vez creada la carpeta, seleccionamos la opcion “Save

current component in a new library” m del editor. Al clicar en esta opcidn aparecera una
ventana, en la que tendremos que seleccionar la ruta de la carpeta “componentes” y “Aceptar”.

iYa hemos creado nuestro array de resistencias!

Llegados a este punto, aparecera la siguiente ventana emergente, que nos avisa de que para
utilizar el componente que acabamos de crear primero tenemos que afadirlo en el proyecto.

i @ This library will not be available until it is loaded by Eeschema.

Modify the Eeschema library configuration if you want to
include it as part of this project.

| Aceptar |

W
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Para afiadir el componente, ya desde la ventana de Eeschema, vamos a seguir los siguientes

pasos:
1. Preferences -> Component Libreries
2. Component library files -> Add ( y buscamos “resistorarray.lib” en la ruta de la carpeta
‘componentes” que anteriormente creamos”
3. User defined search path -> Add (al clicar Add nos llevara a la carpeta “componentes”),

“Aceptar”.

Con estos pasos ya hemos afiadido el componente al proyecto y podremos buscarlo tal y como
hemos hecho con los demas componentes anteriormente.

Haciendo las conexiones

Con todos los componentes colocados en la pantalla, el siguiente paso es hacer las

conexiones. Para ello seleccionamos “Place wire” /

SlRer G aacR B B X Do 1
i . ! &
o SEenmz tmezip 5
T_T | | M| | | | < M| N | 1>
5 +
& ResilstorArrp ResistorArra a
I ! ! =z
=1
15
N 8 N b N 8 bX 5 B
SASEANS SN SASSAS SASSAS SN A
13 o o o o o o o B
g
o | r~| of | | M| | — “A‘
| 1 &
CONN- 01X09 T

Para terminar con el esquema, lo Unico que falta es afadir las referencias del circuito “GND”,

para ello buscamos en la pestafa de “Place power port” = .
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. ResistorArray ResistorArray .

SEadnE |ER2aEs

R EERE T
NN ONM M MM NN
GANZE NS G NEa NGNS a NS NE G A

o eaf I 0 ’:ﬂf\lﬁ\-} ; S
[rrri e GND::::

“CONN_01X09

Llegados a este punto, seria buena idea guardar el trabajo realizado.

Terminado el esquematico y antes de empezar con el PCB, tenemos que asignar la referencia
que permita distinguir entre cada uno de los componentes que hemos utilizado y asignarles un
footprint.

L7A

Para asignar la referencia, vamos a pulsar “Annotate schematic components” 1z | al pulsar
aparecera una ventana que nos da opciones, de las que se puede seleccionar las que mas
adecuadas veamos para nuestro esquema, en este caso vamos a seleccionar:
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< Annotate Schematic

Scope
@® Use the entire schematic

) Use the current page only

) Keep existing annotation
@® |Reset existing annotation

) Reset, but do not swap any annotated multi-unit parts

| Annotation Order
) Sort components by X position m
@® Sort components by Y position 22
Annotation Choice
@ Use first free number in schematic
) Startto sheet number*100 and use first free number

") Startto sheet number*1000 and use first free number

Dialog
| Keep this dialog open

[ Always ask For confirmation

Close Clear Annotation | | Annetate |

Una vez seleccionadas, pulsamos annotate y a continuacién, podremos comprobar cédmo en las
referencias de los componentes que hemos utilizado se ha sustituido el “?” por un nimero.

Coémo hacer huellas (footprint) de componentes

Antes de asignar el footprint a los componentes que hemos utilizado, vamos a crear el footprint
del array de resistencias que hemos creado. Para ello, en la ventana principal de KiCad, vamos

a pulsar sobre el icono de “PCB footprint editor” m .

- Py
: =S K
v @tira_LEDs.pru = i, | ==
> |l componentes -lg;i M ‘! w? m Mb\/
Project name:

72 tira_LEDs.csv /home/jose/Escritorio/tuterial/tira_LEDs.pro
| # tira_LEDs.kicad_pcb
i}l‘%ﬂ tira_LEDs.net

{1 tira_LEDs.sch

m tira_LEDs-cache.lib

Igual que hicimos a la hora de crear un componente, el primer paso es seleccionar la opcion

“‘New Footprint” [:::] en la barra de herramientas superior de la ventana. Al seleccionar esta
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opcidn, aparece una ventana emergente donde nos pide que le demos un nombre a nuestro
footprint, vamos a utilizar el mismo nombre que le dimos al componente: “ResistorArray”.

M @ New Footprint

Enter footprint name;

|:Re5i5tor,&.rray1 |

Cancelar | | Aceptar

Al pulsar “Aceptar”, nos aparecen en la ventana de forma automatica dos textos:
- Nombre del componente: ResistorArray (en color amarillo: capa F.FAb)
- Referencia del componente: **ref (en color azul: capa de silk)

ResistarArray

A continuacién, vamos a colocar los taladros que necesitamos para poder colocar el
componente en el PCB, para ello tenemos que conocer la separacion entre los pines del
componente y el didmetro de las patas del mismo. En nuestro caso vamos a utilizar los
siguientes valores:

- Pitch=2,54 mm

- Diametro = 0,8 mm
Para colocar los taladros, vamos a seleccionar la opcién “Add pads” | o |, en la parte superior
de la barra de herramientas lateral derecha del editor de footprints.

Llegados a este punto, tenemos dos opciones:

- Poner el primer pad como punto de referencia del componente

- Poner el centro del componente como referencia
En este caso vamos a elegir la segunda opcién porque nos ofrece simetria a la hora de rotar y
mover el componente.
Como nuestro footprint tiene 5 pines y vamos a utilizar el centro del componente como
referencia, vamos a situar el primer taladro en las coordenadas (0,0).
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Para ello, en primer lugar, situamos el taladro en cualquier parte de la pantalla y situando el
ratén sobre él, pulsamos la tecla “E” para que nos aparezca la siguiente ventana de
caracteristicas:

| @@ Pad Properties

| General | Local Clearance and Settings
Drill
Pad number: (3] |
Shape: | Circular hole 2
Net name:
SizeX: (0,8 mm
Pad type: Through-hole
SizeY: mm
Shape: Circular
Layers
Position X: o mm
Copper: |All copper layers 2
Position Y: 0 mm
Technical Layers
Size X2 1,6 mm M FAdhes
SizeY: mm | B.Adhes
Orientation: 0 < | deg F.Paste
o 0.1deg B.Paste
Shape offset X: mm il
B.Silks
Shape offset Y: mm
B F.Mask
Pad todielength: |0 mm -
& B.Mask
Trapezoid delta: mm
Dwgs.User
Trapezoid direction: (] Ecotl:User
Parent footprint orientation Eco2.User
Rotation: 0,0
Board side: Frontside

£
Cancelar | | Aceptar | |
]

En ella vamos a cambiar:
- Pad number: 3
- Position X: 0
-  PositionY: 0
- Size X: 1,6 mm (el doble del diametro del drill, relacién que aparece por defecto)
- Drill -> Size X: 0,8 mm.

Una vez colocado el primer componente, vamos a mover los textos que nos aparecieron al
principio a un lugar provisional, donde no nos molesten para crear el footprint. Después,
procederemos de la misma forma que hicimos con el primer taladro.
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% Pad Properties

|| General | Local Clearance and Settings
Pad number: |4 bt
Shape: | Circular hole 2
Net name:
SizeX: |0,8 mm
Pad type: Through-hole 2
SizeY: mm
Shape: Circular =
S Layers
Position X: 12,54 mm
Copper: | Allcopper layers -
Position Y: o mm >
Technical Layers
Size X: 1,6 mm EAdhes
SizeY: mm B.Adhes
Orientation: 0 > | deg F.Paste
o 0.1deg B.Paste
Shape offset X: mm e
B.Silks
Shape offsetY: mm
& F.Mask
Pad to dielength: |0 mm -
& B.Mask
Trapezoid delta: mm
Dwgs.User
Trapezoid direction: Ecol.User
Parent footprint orientation Eco2.User
Rotation: 0,0
Board side: Front side

Cancelar | | Aceptar |

Los taladros 2 y 4, estaran a la misma distancia del centro: -2,54mm y 2,54mm
respectivamente.

Los taladros 1y 5, estaran al doble de separacién que el 2 y el 4, es decir, 2,54*2 = 5,08mm
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- ResistorArray

Como se puede apreciar en la imagen anterior, el taladro 1 tiene diferente huella que los
demas, hacemos esto para diferenciar de una forma clara cual es la pata nimero 1 del
componente, que en este caso, corresponde con el terminal comun del array de resistencias.
Para cambiar la forma de la huella, solo tenemos que cambiar el “Shape” como se ve en la
siguiente imagen:

W-Xa

Pad Properties

{| General | Local Clearance and Settings
Drill
Pad number: |1 ;
Shape: | Circular hole 2
Net name:
Sizex: 0,8 mm
Pad type: Through-hole
Size: mm
Shape: Rectangular
Layers
Position X: -5,08 mm
Copper: | All copper layers 3
Position Y: 0 mm .
Technical Layers
Size X: 1,6 mm F.Adhes
SizeY: 1,6 mm B.Adhes
Orientation: 0 : | deg F.Paste
0 0.1deg B.Paste
Shape offset X: 0 mm leile
B.SilkS
Shape offset Y: 0 mm
[ F.mask
Pad to die length: 0 mm .
& B.Mask
Trapezoid delta: mm =
Dwgs.User
Trapezoid direction: Ecol.User
Parent footprint orientation Eco2.User
Rotation: 0,0
Board side: Front side

Cancelar Aceptar

A la hora de disefar circuitos, es una buena practica, que el terminal comun o negativo de los
componentes coincida con el PAD cuadrado o diferente del footprint, esto nos facilitara su
colocacion a la hora de soldarlos.
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El siguiente paso en la creacion del footprint es dibujar el perimetro del componente, para ello

vamos a seleccionar la opcion “Add graphic line or polygon” del menu de la derecha 3 y
vamos a dibujar un rectangulo alrededor de los taladros que hemos colocado. Antes de
empezar a dibujar, tenemos que seleccionar la capa sobre la que queremos que situar el
poligono, vamos a seleccionar, en primer lugar “F.SilkS”:

Visibles

Layer | Render

ResistorArray

b= & Fsilks

Enable this For visibility

Y una vez que tengamos el rectangulo en F.SilkS, vamos a repetir el paso en la capa “F.FAb”

Visibles

Layer |Render
= &
LI~}
=@ F.Adhes
= @& B.Adhes
m [ FPaste
=)@ B.Paste
=& Fsilks
= & Bsilks
=@ F.Mask
=& B.Mask

~ ResistorArray

D S —

AREE@

=@
=)@ Fcrtvd
& B.Crtyd
b=/ & FFab

Enable this for visibility

Conviene, que el rectangulo que hemos dibujado se aproxime lo maximo posible al tamafo real
del componente que vamos a utilizar, de este modo, nos ayudara a saber cémo de cerca
podremos colocar otro componente a la hora de crear nuestro PCB.

Llegados hasta aqui podemos aproximar los textos al componente para que no estén muy lejos
de él y nos sirvan como referencia a la hora de colocarlo en PCB.
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Para terminar, solo tenemos que guardarlo. Para ello, vamos a utilizar la opcién “Create new

library and save current footprint” r:m en el menu superior del editor.

Al pulsar, nos aparecera una ventana emergente que nos pedira un destino y un nombre para
nuestra libreria. En este punto, recordar, que si guardamos la libreria en una carpeta y
posteriormente la cambiamos de sitio, no podremos volver a usarla a menos que la volvamos a
afnadir, de modo que, se recomienda guardarla en una carpeta especifica para librerias que no
vaya a ser movida.

Seleck Footprint Library Folder

The footprint library is a folder with a name ending with .pretty
Footprints are .kicad_mod files inside this folder.

Path base:

[l tutorial =

Library folder (.pretty will be added to name, if missing)
|ArrayResistor]

Cancelar | | Acepkar |

Una vez seleccionado el nombre y el destino seleccionamos “Aceptar” y ya tenemos el foprint
para nuestro componente. Ahora solo queda afadirlo para que pueda ser usado.

Anadir librerias con footprints

A medida que vayamos disefiando PCB, iremos utilizando diferentes componentes, cuyos
footprints no siempre van a estar incluidos en las librerias basicas de KiCad. Es posible que
tengamos que crear nuevas librerias o que encontremos librerias con multiples componentes
que contengan lo que necesitamos. Para poder utilizarlas tenemos que anadirlas a nuestros
proyectos. Para ello, vamos a seguir los siguientes pasos:

Abrimos PCBnew en la ventana principal de KiCad ~" |, Una vez abierto, seguimos la
siguiente ruta: Preferences -> Footprint Libraries Wizard.

En la pantalla emergente que aparece, clicamos “Next” y a continuacion buscamos la carpeta
donde hemos guardado nuestra libreria.

Cuando hayamos seleccionado la carpeta correspondiente, clicamos “Next”. Si la libreria es
valida, en la siguiente ventana aparecera un “OK” en la casilla de “Status”, solo nos restara
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hacer click en “next” e indicar si queremos afadir la libreria de forma global o solo para este
proyecto y clicar en “finish”.

Hecho esto, podemos utilizar el footprint que hemos creado en nuestros proyectos.

La secuencia de pasos descrita se muestra en las siguientes 4 imagenes:

o Add Footprint Libraries Wizard

Welcome to the Add Footprint Libraries Wizard!

Please select the source for the libraries to add:
@ [Files on my computer

() Github repository

{vr]
T

0 Visit our official Kicad repository on Github and get more libraries
| MNext> | | cancelar |

o Add Footprint Libraries Wizard

Select files or folders to add:

[ Kicad |
[ leds |
[l Proyectos

[ tutorial

L@l ™ ArrayResistor.pretty

[ 3
[ 3
[ 2
v

* [ componentes
> [ silks
» [ Escritorio.pretty
» [ Imagenes

| Allsupported library formats -

| =Back Cancelar |
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o Add Footprint Libraries Wizard

Review and confirm the changes to the libraries:

Library Status Format
|ArrayResistor OK _§_K_i(:qd
Next >

| =Back

Cancelar |

Add Footprint Libraries Wizard

() To the current project only

<Back [ Finish J Cancelar

Asignado de footprints

Para asignar footprint a los componentes utilizados seleccionamos: “Run CvPcb to asociate

B

components and footprints”. = =
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En la ventana que aparece a continuacion, vamos a asignar los siguientes footprints a los
componentes:

ARG 4 x UL\ Y E[F

Componente

Footprint

LED

LEDs: LED 5.00mm

Array de resistencias

ArrayResistor (footprint que acabamos de crear)

Conector

Pin Headers: Pin_Header_Straight_1x09_Pitch2,54mm

Buttons_Switches SMD

Buttons_Switches ThroughHole,

Buzzers_Beepers
Capacitors_SMD
Capacitors_Tantalum_SMD
Capacitors_ThroughHole
Choke_Axial ThroughHole
Choke_Common -Mode_Wurth
Choke_Radial ThroughHole
Choke_SMD

Choke_Toroid ThroughHole
ComponentesVarios
Connect
Connectors_Molex
Converters_DCDC_ACDC
Crystals

Diodes_SMD
Diodes_ThroughHole
Discret

Display
Displays_7-Segment
Divers

ESPO1

EuroBoard_Outline

G0« » B ek
AV_Conn

Air Coils SML NEOSID
ArrayResistor

D1 - LED : LEDs:LED_D5.@mm 1 ArrayResistor:ResistorArray
2 D2 - LED : LEDs:LED D5.@mm

3 D3 - LED : LEDs:LED D5.0mm

4 D4 - LED : LEDs:LED D5.0mm

5 D5 - LED : LEDs:LED D5.0mm

6 D6 - LED : LEDs:LED D5.0mm

7 D7 - LED : LEDs:LED_D5.@mm

8 D8 - LED : LEDs:LED_D5.@mm

g J1 CONN_01X@9 : Pin_Headers:Pin_Header Straight 1x09

10 U1l ResistorArray : ArrayResistor:ResistorArray

\rrayRes

Cuando hayamos asignado footprint a todos los componentes guardamos y cerramos.
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Generar archivos para crear PCB

De vuelta en Eeschema, tenemos que generar una NETLIST, que sera utilizada para
establecer las conexiones entre componentes en el PCB, y también un archivo BOM o “Bill Of
Materials” en el que se lista cada uno de los componentes que hemos utilizado.

Para generarlos, en primer lugar vamos a pulsar sobre la pestafia “Generate Netlist” y vamos a
seguir los siguientes pasos:

1. Generate

2. Guardar
Esto creara un archivo con el nombre de nuestro proyecto y extensién .net en la carpeta
contenedora.

En segundo lugar vamos seleccionar la pestana “Generate Bill of materials and/or cross
references”. Para generar el BOM nos hace falta afadir un plugin en la ventana que aparece.
Para generar dicho plugin:

1. Clicamos en Add Plugin

2. Buscar el plugin de nombre : "bom2csv” en la ruta /usr/lib/kicad/plugins/

3. Sustituir el texto que aparece por defecto en el recuadro Command Line por:

xsltproc -0 " %0O.csv" "/home/<user>/kicad/eeschema/plugins/bom2csv.xsl" " %I"

4. Generate.
Al seguir estos pasos se van a generar archivos en la carpeta contenedora con extension .xml y
.CSV

A continuacion, guardamos nuestro esquema y estamos listos para empezar a disefiar nuestro
PCB.

2. PCB

Para empezar con la edicion de nuestro PCB, tenemos que abrir, desde la ventana principal de

KiCad, PCBnew | —— .
Igual que hicimos con el esquema, el primer paso en la creacion del PCB, es darle un nombre y
seleccionar un tamafo de pagina, para ello vamos a File -> Page Settings y fijamos el tamafno

de la hoja a A4 y le damos un titulo al esquema: LEDs Strip.
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Bordes de placa

A continuacién tenemos que delimitar el espacio en el que vamos a fijar los componentes, es
decir, delimitar los bordes de nuestra placa. En caso de que queramos una placa con una
forma basica, se puede crear desde el editor de PCB (PCBNew).

Para ello tenemos que seleccionar la capa Edge.Cuts y la opcion “Add graphic line or polygon”.

WL ST @2 0Q (@ &K Buecs :H BT O @
Track: 0,250 mm (9,84 mils) * : || Via: 0,60 mm (23,6 mils)/ 0,40 mm (15,7 mils) * : % Grid: 0,0025 mm (0,10 mils) o Zoom 0,73

Visibles

Layer | pander

RICILS Bk
®

Add graphic line or polygon
B Ecotuser

o =
T B Ecoz.user
b= Edgecuts
'.E.I m | [§F Margin
m|[{ Fortyd
$ B s.crtvd
B rrab

m|[§F B.Fab

¥«

Para disefios de bordes de placa mas elaborados vy, por tanto, dificiles de hacer utilizando el
método anterior, existen otras opciones.

A continuacién vamos a explicar dos formas diferentes de anadir a PCBNew un borde de placa
creado con inkscape.

Borde de placa como componente

En primer lugar, vamos a explicar cdmo convertir la forma creada en inkscape en un
componente de PCBNew. Para ello vamos a utilizar un script hecho en python disponible en:
https://github.com/mtl/svg2mod. Es necesario que aclaremos, que con este script no solo se
pueden generar bordes de placa, sino que se puede crear cualquier tipo de componente que
necesitemos utilizar en PCBNew.

Para mas informacién de como utilizar el script consultar el Readme de Github.

El proceso de creacion de un borde de placa utilizando éste método es el siguiente:
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1. Creacioén de la forma utilizando Inkscape

= 3 P Flalz=
i - B B P PR I IR I8 PR B PR ) BScapas (Mayls+Cril) 3 [
= ] % B i
f\ 3 Edge.Cuts =1 5
£ 4 B
Q &
7 5
@ g |
@ =
& 1 »
x| *
ol o
W .
N g 6
=
v Q
| Modo de mezcla: | Normal @ S
A L — &}
wg ] - =)@
o E [Bs Alinear y distribuir (Mayts+Ctrl+A) 5
- [# Relleno y borde (Maytis +Ctrl+F) ‘A
Q 5 2= Capas (Mayuis+Ctrl+l) a al B
Zc\’ ] @
/3 L
= = 1
s

v

Es muy importante que todos los elementos que utilicemos para crear la forma de placa
sean trayectos, de lo contrario, el script no actuara sobre ellos. Para convertir un objeto
a trayectos tenemos que ir a:

Trayecto -> Objeto a trayecto (Ctrl+Mayus+C)
Como queremos que la forma que hemos creado nos sirva de borde de placa, la vamos
a colocar en una capa llamada Edge.Cuts y a continuacion guardamos el archivo con el
nombre “leds_dim.svg” en una carpeta llamada “silks” dentro de la carpeta contenedora
de nuestro proyecto.

2. Ubicacién del script
Una vez que tenemos la forma creada, tenemos que descargar el script mencionado de
github y descomprimirlo. En la carpeta que se genera al descomprimirlo tenemos que
situar una copia del archivo “leds_dim.svg”.

3. Generar Componente para PCBNew (componente.mod)

Abrimos el terminal de nuestro ordenador y accedemos desde él a la carpeta generada
al descomprimir el archivo descargado de Github con el terminal.
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Una vez en dicha carpeta, utilizamos los siguientes comandos para generar el
componente: python svg2mod.py -i leds_dim.svg -p 1 -f 0.94 (hemos llegado a esta
configuracién probando diferentes combinaciones que hemos obtenido del archivo
Readme del script, son los que a nosotros nos funcionan, no quiere decir que sean
validos para todo el mundo, os invitamos a que probéis otras configuraciones)

Una vez ejecutado el script, en la carpeta donde hemos copiado el archivo
“leds_dim.svg” aparecera un un archivo con el mismo nombre, pero con extension
“.mod”. Este archivo es el componente que contiene la forma de placa que hemos
generado en Inkscape y que nos va a servir de forma de placa en PCNew.

Anadir componente a PCBNew

Antes de afiadir el componente a PCBNew es necesario saber que tenemos que situar
el archivo “.mod” en un lugar fijo, es decir, si afiadimos el componente a PCBNew y
posteriormente cambiamos la ubicacion del archivo .mod, el componente en PCBNew
dejara de ser utilizable.

Para evitar que esto suceda, una solucién puede ser: Crear una carpeta para
componentes en “Mis documentos” en la que afiadamos todos los componentes que
vayamos creando.

Con el archivo.mod en una su ubicacion final, los pasos a seguir para afnadir el
componente a PCBNEW son:
1. Abrir “Add footprint libraries wizard” en la pestafna “Preferences”

! Add Footprint Libraries Wizard
@7’ Welcome to the Add Footprint Libraries Wizard!
sl
" Please select the source For the libraries to add:

@® |Files on my computer

Github repository

o Visit our official Kicad repository on Github and get more libraries

| Next> | | Cancelar
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2. Ir alaruta donde se encuentra el archivo.mod

o

Add Footprint Libraries Wizard

@ Select files or Folders to add:

* [ Proyectos

¥ | tutorial
* @ componentes
¥ [ silks

Il Escritorio.pretty
Il Imagenes

s MEGA

i Musica

v v v ¥

All supported library formats =

<Back | MNext= | | Cancelar

3. Comprobacién de que el archivo se ha creado correctamente

£ @ Add Footprint Libraries Wizard

m Review and confirm the changes to the libraries:
Library Status Format

leds_dim OK Legacy

<Back | NexE=| | Cancelar

Si en esta ventana el estado no es OK, el componente se habra creado mal y
habra que repetir el proceso de creado del componente.
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4. Anadir el componente solo para este proyecto

oo

Add Footprint Libraries Wizard
Where do you wish the new libraries to be added:
IE;J
% To global library configuration (visible by all projects)

@ [To the current project only

<Back | Finish. | | Cancelar

En este caso, como se trata de un componente que contiene la forma de esta
placa concretamente, vamos a afnadir el componente para que solo sea visible
en este proyecto. En funcién del componente que creemos, se pueden anadir de

forma global, y de esta forma, que sea accesible desde cualquier proyecto que
creemos.

5. Encontrar componente

Ya tenemos el componente disponible para ser utilizado en PCBNew, solo nos
queda encontrarlo, para ello vamos a utilizar la opcién “Add footprints”

Load Footprint

¢ A0~ BBE S >

_Name:
|

History list:

| Aceplar

Search by Keyword
Cancelar
List All

Select by Browser

Y en esta ventana seleccionamos “Select by Browser”
Ya solo nos queda buscar en el menu de la izquierda el nombre de nuestro

componente y cuando lo encontremos, hacer doble click sobre él en el menu
central.
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R R
Sockets MOLEX_KK-System svg2mod
Sockets_Mini-Universal svgzmod-rev
Sockets WAGO734

Switch

symbols

TO_SOT_Packages_SMD
TO_SOT_Packages_THT

Terminal_Blocks

Transformers_CHK
Transformers_SMPS_ThroughHole
Transistors_OldSowjetAera

Valves

Varistors

Wire_Connections_Bridges

Wire_Pads

amp_dim

amp_serial

ampli_dim

ampli_serial

conn_dF13

hirose_conn_df13

jack_audio

logos

pata
pth_Resistors
user_molex

Borde de placa como DXF

En segundo lugar, vamos a importar la forma de placa que hemos creado anteriormente en
inkscape como un archivo DXF en PCBNew.
Para ello, los pasos que tenemos que seguir son los siguientes:
1. Exportar el archivo de KiCad como un archivo DXF, para ello vamos a:
Archivo -> Guardar Como
Aqui indicamos el nombre que le vamos a dar a nuestro archivo y en la extension,
tenemos que seleccionar la opcién .dxf.

Lugares Nombre 4 Tamano Modificado
Q, Buscar B board_dim.dxF 3,7kB  15:32

@ Usados recient...

= jose

@ Escritorio

. Sistema de arc...
[l templates

i Documentos

il Misica

(@ Imagenes

[ videos

5 Descargas

& Anadir la extensién del archivo automaticamente X o
== = 5 o Ploter de corte de escritorio (AutoCAD DXF R14) (*.dxF) 2
&4 Activar vista preliminar

Cancelar | [ Guardar |

A continuacién pulsamos “Guardar” y nos aparecera una ventana emergente, donde
seleccionaremos las siguientes opciones:
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Pléter de corte de escritorio

Opciones | Ayuda

B usar el tipo de salida spline ROBO-Master
usar el tipo de salida de linea LWPOLYLINE

Unidad base | mm <
Codificacion de caracteres | Latin 1 =
Layer export selection | All (default) =

Layer match name

Cancelar Aceptar

2. Una vez que tenemos nuestro archivo DXF, todavia no podemos anadirlo a KiCad,
porque, el archivo que inkscape genera es R14 y KiCad permite importar R12, por lo
que tendremos que transformar el archivo generado. Para ello, vamos a utilizar
librecad, (http://librecad.org/cms/home.html). Con este programa vamos a convertir el
archivo en el formato adecuado en pocos pasos:

Abrimos librecad y vamos a la ruta:
File -> Open y seleccionamos el archivo que hemos creado con inkscape.

o3

FHRIAIX -+ - Ll REEEE ( AE B B CELEBME-
1By Layer 2| —Bylayer : By Layer

o

unnamed document 1 D Layer List &

Open Drawing @ | [

Look in: &l /home/jose/Escritorioftutorial/silks =] L4 A B B |E

E Computer Name Size Type Date M
| jose | board_dim.dxf 3KB dxfFile  27/7/1]

Block List &

File name:

Files of type: | Drawing Exchange (*.dxf) = Cancel

[E3]

« Command:

Clear
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Cuando lo hayamos abierto, aparecera nuestra forma de placa en la pantalla. Vamos a
continuar seleccionando todo el dibujo y a continuacién vamos a:
Modify -> Explode.

3. Para finalizar, vamos a guardar nuestro borde de placa en el formato correcto:
File -> Save as

0 Save Drawing As

Look in: &l /home/jose/Escritorio/tutorial/silks 1€ 2 A B [E|F
!_ Computer Name v |Size Type Date M
(8 jose |1 board_dim.dxf 9 KB dxfFile 27/7/17

File name:  |leds_dim.dxFf [ save

Files of type: | Drawing Exchange DXF R12 (*.dxf) 2 Cancel

Aqui tenemos que seleccionar la opcion DXF R12.

Con estos tres pasos ya tenemos lo necesario para poder afiadir el borde de placa en PCBNew
como DXF. Para afadirlo, solo tenemos que ir a la ruta:

File -> Import -> DXF Files

O Open File
#| | +|@jose B Escritorio | tutorial || sitks
Lugar: [leds_dim.dxf

Lugares Nombre 4 Tamafio Modificado

Q Buscar B board_dim.dxF 9,2kB 1544
@ Usados recient... | [EEEEERTTE 72,9kB  15:54
@ jose

B Escritorio

i sistemadearc.

¥ Documentos

@ Masica

@ Iméagenes
[@ videos
@ Descargas

DXFFiles (*.dxf)

Cancelar Abric |

Aqui seleccionamos el archivo deseado, y al pulsar “Aceptar” no saldra una ventana similar a la
siguiente:
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X import DXF File

: Browse :

Place DXF origin (0,0) point:
| Center of page

X Position: [190

| Upper left corner of page Y Position: |97

| Center left side of page
Units: | 'mm

S -

| Lower left corner of page

-

@ User defined position
Layer: Edge.Cuts =
Cancelar | | Aceptar |

En ella, tenemos que seleccionar la capa “Edge.Cuts”, porque es un borde de placa (en caso
de que fuese un silk u otro tipo de archivo podriamos seleccionar la capa correspondiente en
“‘layers”) y donde y como queremos importarla, en este caso, hemos elegido definir el punto
donde se va a posicionar.

Al pulsar aceptar, el borde de placa quedara importado.

Existe mas informacion acerca de como crear este tipo de archivos e importarlos en KiCad en
el capitulo 6 del manual de KiCad. (http://kicad-pcb.org/help/documentation/)

Agujeros de fijacion

Ahora que tenemos delimitados los bordes de la placa, vamos a colocar los agujeros que
serviran para poderla anclar a otra superficie.

Para ello vamos a buscar un componente llamado: SolderWirePad_single_xxmmbDirill, donde
“xx” es el tamafio del dril. En este caso no es importante el didametro que elijamos, puesto que
lo vamos a modificar.
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Sockets_ MOLEX_KK-System
Sockets_Mini-Universal
Sockets_ WAGO734

Switch

Symbols
TO_SOT_Packages_SMD
TO_SOT_Packages_THT
Terminal_Blocks
Transformers_CHK

Transformers_SMPS_ThroughHole

Transistors_OldSowjetAera
Valves

Varistors
Wire_Connections_Bridges
Wire_Pads

amp_dim

amp_serial

ampli_dim

ampli_serial

conn_df13
hirose_conn_df13
jack_audio

leds_dim

logos

pata

pth_Resistors

user_molex

SolderwirePad_2x_2-5mmDrill
SolderwirePad_2x_2mmbrill
SolderwirePad_3x_0-8mmDrill
SolderwirePad_3x_1-2mmDrill
SolderwirePad_3x_1-5mmDrill
SolderwirePad_3x_1mmbDrill
SolderwirePad_3x_2-5mmDrill
SolderwirePad_3x_2mmbDrill
SolderwirePad_4xinline_0-8mmDrill
SolderwirePad_4xInline_1-2mmDrill
SolderwirePad_4xInline_1-5mmDrill
SolderwirePad_4xinline_1mmDrill
SolderwirePad_4xinline_2mmDrill
SolderwirePad_4xSquare_0-8mmDrill
SolderwirePad_4xSquare_1-2mmDrill
SolderwirePad_4xSquare_1-5mmDrill
SolderwirePad_4xSquare_1mmbrill
SolderwirePad_4xSquare_2-5mmDrill
SolderwirePad_4xSquare_2mmbrill
SolderwirePad_4xinLine_2-5mmDrill
SolderwirePad_single_0-8mmDrill
SolderwirePad_single_1-2mmDrill
SolderwirePad_single_1-5mmDrill
SolderwirePad_single_1mmDrill
SolderwirePad_single_2-5mmDrill
SolderwirePad_single_2mmDrill
SolderwirePad_single_ SMD_5x10mm
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SolderWirePad_single_1—5mmD.rill

Para modificarlo, situamos el ratén en encima del componente y pulsamos la tecla “E”.

Pad Properties

General | Local Clearance and Settings

Pad number: |1

Netname:
Pad type: Through-hole
Shape: Circular
Position X: 165,735
Position Y: 103,632
size X: |35
Size Y:
Orientation: 0

0
Shape offset X:
Shape offset Y:

Pad to die length: 0
Trapezoid delta:
Trapezoid direction:

Parent Footprint orientation
Rotation: 0,0
Board side: Front side

mm

mm

mm
deg
0.1deg
mm
mm
mm

mm

Drill
Shape:
Size X: (3,5
Size Y:
Layers

Copper:

Technical Layers

F.Adhes
B.Adhes
F.Paste
B.Paste
E.silks
B.Silks

& F.Mask

& B.Mask
Dwgs.User
Ecoi.User

Eco2.User

Circular hole

All copper layers =

Cancelar

Aceptar

En la ventana que se abre, vamos a modificar la medida del drill y la vamos a fijar en 3,5mm. y
la del shape del mismo valor.
Una vez seleccionado el tamafio, vamos a situar el componente. Para ello, podemos modificar
las coordenadas en la ventana en la que hemos modificado el componente, o bien,
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“arrastrarlo” y situarlo con el ratdn, para lo cual, necesitamos situar el ratén encima del
componente y pulsar la tecla “M”.
Operaremos de la misma forma con el otro taladro.

Snlder\direis'é"'d;.g-__[_ngle_i—5m m Drill SolderWirePad_single-f—5mmDrill

Colocado de componentes

Situados los taladros para fijar la placa, vamos a empezar con la colocacién de los
componentes y el trazado de las pistas. Para ello necesitamos leer la Netlist que hemos creado
anteriormente en Eeschema: Pulsamos sobre el icono Netlist y la importamos presionando
“‘Read Current Netlist”.
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= & & o @Gk wuewn - BERA €

ia: 0,60 mm (3 an

Netlist
Footprint Selection Unconnected Tracks
@® Reference ® Keep Read Current Netlist
Timestamp Delete
Close
Exchange Footprint Extra Footprints
@ Keep @ Keep Test Footprints
Change Delete
. Rebuild Board Connectivity
Single Pad Nets
® Keep Save Messages to File
Delete

Dryrun. Only report changes in message panel
Silent mode

Netlist File:
/home/jose/Escritorio/tutorial/tira_LEDs.net Browse

Messages:

Filter: & All Save report to file...

Con ésto, nos apareceran todos los componentes que hemos utilizado anteriormente para crear
el esquematico unidos por finas lineas, que marcan las conexiones entre ellos.

En primer lugar, vamos a colocar los LED. Para ello, vamos a fijar una distancia de separacion
aproximadamente 7mm.

Cuando hemos colocado los dos LEDES centrales, para colocar el resto solo tenemos que
conocer las coordenadas “x” e “y” de uno de ellos. Conocidas situaremos el ratén encima del
siguiente LED a colocar y pondremos la misma coordenada “y” que el LED ya posicionado y la
coordenada “x” sumandole 7mm.
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En esa misma ventana, también hay que modificar la orientacion de los LEDES, que sera de
-90°.

Coordenadas D4 Coordenadas D3
: Properties | 3D settings ! Properties | 3D settings
|| Reference Change Footprint(s) Reference Change Footprink(s)
[pa | Edit b3 | |Edit
Value Foatprint Editor Valile Footprint Editor
LED Edit| Attributes Move and Place LED Edit| Attributes Move and Place
Board Side @ Normal O Free Board Side @ Normal Free
@ Front ) Normal+nsert @® Lock pads @® Front ) Normal+Insert @ Lock pads
- Back ) Virtual ) Lock Footprint ) Back O Virtual Lock footprink
Rotation Auto Place Rotation Auto Place
0.0 Rotate 90 degrees Rotate 180 degrees 000 Rotate 90 degrees Rotate 180 degrees
_) +90.0 0 0 ) +90.0 0 0
® 90,0 @® -90.0
- 180.0 (1] 10 0 10 ~ 180.0 (1] 10 0 10
") Other Local Settings ) Other Local settings

Pad connection to zones: | Use zone setting Pad connection to zones: | Usezonesetting =

Rotation (in 0.1 degrees): : Rotation (in 0.1 degrees):

Set clearances to 0 to use global values Set clearances to 0 to use global values
Position Pad clearance: 0 mm Position Pad clearance: 0 mm
X |152,23756 mm X |145,23756 mm
Y |84 mm  Solder mask clearance: 0 mm Y |84 mm Solder mask clearance: 0 mm
Sheet path: Solder paste clearance: -0 mm Sheet path: Solder paste clearance: -0 mm
/593A663F Solder paste ratio clearance: |-0,000000 % /593A6738 Solder paste ratio clearance: |-0,000000 %
[ 1}
Cancelar | |JAcepkars | Cancelar | Aceptar | |

Procediendo de la misma forma con los demas LEDES restantes, llegaremos a una placa de
estado similar a este:

Como se ve en el renderizado 3D (View->3D Viewer o Alt+3), los LEDEs no estan pegados a la
placa, esto se puede corregir situando el ratén encima del LED y pulsando la tecla “E”. En la
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ventana que aparece, seleccionamos la opcion “3D settings” y dentro de esa pestana,
modificamos el valor del offset en el eje Z.

E @ Footprint Properties

Properties | 3D settings

3D Shape Name

Default Path (From KISYS3DMOD environment variable)

IN LEDs.3dshapes/LED_D5.0mm.wrl

| fust/share/kicad/modules/packages3d/

3D Scale and Position
Shape Scale:

X |0,393701

Y. |0,393701

Z: |0,393701

Shape Offset (inch):

X: |0,000000

Y. |0,000000

Z: [.0,120000

Shape Rotation (degrees):

X 10,000000

Y: | 0,000000

Z: |0,000000

Edit Filename

| Add3DShape |

| Remove 3D Shape |

Cancelar
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Del mismo modo que con los LEDES procedemos a colocar el resto de componentes que nos

quedan.
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Rooteado

Para rootear la placa vamos a seleccionar la opcion “Add tracks and vias”. Esto nos va a
permitir crear pistas de conexion entre los diferentes componentes, pero antes de empezar con
las vias, tenemos que definir el tamafo de las mismas en: Design Rules -> Design Rules Editor
-> Global Design Rules. En esta pestafia, vamos a poner un tamafo de pista de 0,4mm.
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e @ @ Design Rules Editor

]
3 NetClasses Editor | Global Design Rules

Via Options:
Blind/buried vias:
@& Do not allow blind/buried vias
_) Allow blind/buried vias
Micro Vias:
@® Do not allow micro vias

Allow micro vias

Minimum Allowed values:

Min track width (mm): |0,2

Min via diameter (mm): | 0,4

Min via drill dia (mm): 0,3

Min uvia diameter (mm): |0,2

38

Min uvia drill dia (mm): 0,1

Specific via diameters and track widths, which

can be used to replace default Netclass values

on demand, For arbitrary vias or track segments.
Custom Via Sizes: Custom Track Widths:

Drill value: a blank or 0 => default Netclass value

Diameter Drill width

Via 1 Track 10,400

Via2 Track 2 I:l
via3 Track 3

Via4 Track 4

Vias Track 5

Via 6 Track 6

Via7 Track 7

Vias Track B.

Cancelar Aceptar

Teniendo el tamafio de pistas deseado, procedemos con el rooteado de la placa.

SR =M AR (E G Weaeon : @IEE S @
Track: 0,250 mm (9,84 mils) * : || Via: 0,60 mm (23,6 mils)/ 0,40 mm (15,7 mils) * 2 % Grid: 0,0025 mm (0,10 mils) = Zoom 10,00
Visibles

Laver | Render

Qg

a (n(n(n (= (0 (u (0 (0 (=
(S

m
=

F.Adhes
B.Adhes
F.Paste

B.Paste

F.SilkS

o o
oo

B.SilkS
F.Mask

B Dwos.user
m | [§ Cmts.User
m | B Ecol.User

[ Ecoz.user

[ Edoecuts
m | [§ Margin
m| @ Fortyd

Het—(D3-RadZ)

&
T
=
0]

Het=(D1-Pa

& B.Crtvd
& Frab
=& BFab

¥+ g0 FEEG o

Para seleccionar la capa de la placa en la que queremos situar la pista, cambiamos la seleccién
de la capa en el menu de capas de la derecha.

En caso de que necesitemos hacer una via, podemos pulsar la letra “V” mientras se esta
haciendo una pista, o hacer “click” con el botén derecho del raton y seleccionar la opcion “place
through via”.
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Vamos a rootear todas las pistas, exceptuando las pistas de masa “GND”.

Para rootear las pistas que quedan, que son las pistas de GND, vamos a crear planos de masa
seleccionando la opcion “Add filled zones”.

Después, haremos “click” en cualquier parte de la pantalla y aparecera la siguiente ventana:

@ & Copper Zone Properties
Layer: Net: Net Filtering
I F.Cu <no net> Display:
N B.Cu GNL show all (pad count) 2
Net-(D1-Pad1)
Net-(D1-Pad2) Hidden net filcer:
Net-(D2-Pad1) HEL?
Net-(D2-Pad2) Visible net filter:
Neb(D3-Pad1) #
Nek(D3-Pad?) -
Net-(D4-Pad1) Apply Filters
Settings
Clearance (mm): Pad connection: Priority level: Outline slope:
0,15 Thermal relief +||o = Arbitrary 2
Minimum width (mm): Thermal Reliefs Fill mode: Outline style:
0;13 Antipad clearance (mm): Polygon = Hatched
Corner smoothing: 0,508 om0
None B Spoke width (mm): 16 Z
0,508
Export Settings to Other Zones Cancelar Aceptar |

Donde primero vamos a seleccionar la capa TOP (color rojo) y GND, después de pulsar
“Aceptar”, tendremos que dibujar un poligono que contenga toda nuestra placa.
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| RésistorArray—

Ya solo nos queda hacer “click” con el botén derecho del ratén y seleccionar la opcién “Fill or
Refill all zones” o pulsar la tecla “B”. Con ello, se rellenara el plano que acabamos de construir
uniendo todos los pines de conectados a GND.

_Uz <

= ¥
- ~— — Al
S - e = e e s A s & s ’ il =
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Antes de continuar con los siguientes pasos, tenemos que verificar que lo que hemos hecho

41

cumple con las reglas de disefio y que no nos hemos dejado ninguna conexién por hacer. Esto

lo vamos a hacer con la opcién “Perform design rules check”. il .

Al pulsar sobre el icono, se nos abre una ventana en la que tenemos que pulsar “Start DRC”.

Cuando pulsemos, el programa hara una serie de comprobaciones y al finalizar tendremos una

ventana como la siguiente:

Options:

Clearance
Min track width |0,2
Min via size |0,4
Min uViasize |0,2
Create Report File
Error Messages:

Problems / Markers

Messages:

Compile ratsnest...

Pad clearances...

Track clearances... | Start DRC |
Fillzones...

Testzones... List Unconnected
Unconnected pads...
Keepout areas ...
Test texts...
Finished

Delete All Markers

Cancelar Aceptar

Si todo esta bien, la parte inferior de la ventana estara en blanco. En caso de que hayamos
cometido algun error en la ventana “Problems” aparecera y al hacer doble click sobre él, el
programa nos llevara hasta el punto donde se ha producido. Lo mismo ocurre si nos hemos
dejado alguna conexion sin hacer, solo que aparecera en la ventana “Unconnected”.
Cuando en hayamos solucionado todos los errores que nos aparezcan tendremos todo lo
necesario para generar los archivos “gerber” y mandar a fabricar nuestro PCB.

En nuestro caso, antes de dar por finalizado el proceso de creacion, vamos a anadir texto
descriptivo que facilitara el montaje del PCB y su utilizacion, este texto recibe el nombre de silk.

Silks

El footprint de cada uno de los componentes esta formado por diferentes partes:
- Drills a través de los que hacemos las conexiones.

- Parte grafica, que indica cual es el tamafo del componente, es muy Util para hacernos

una idea de lo que ocupan los componentes a la hora de situarlos.
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8,0,0,0,0,0.0,0,

Como se ve en el render de la placa, esa parte grafica forma parte de nuestro disefio, es decir,
cuando generemos los archivos gerber, va a aparecer en ellos, aunque ya no sea necesaria.
Por este motivo, en primer lugar, vamos a borrar las graficas de los componentes, que, una
vez situados, no necesitamos. Para ello vamos a editar el footprint del componente situando el
ratén encima del componente que queramos editar y pulsando la tecla “E” y a continuacion
seleccionamos la opcion “Footprint Editor”.

2l Footprint Properties

i Properties | 3D settings

[ || Reference

ps | |Edit

Value

LED Edit

Board Side
@® Front
) Back
Rotation
0.0
1 490.0
@® -90.0
1 180.0
) Other

Rotation (in 0.1 degrees):

Position

X |180,23756 mm
Y (83,5 mm
Sheet path:

/593A67B1

Change Footprink(s)

Footprint Editor

Attributes Move and Place
® Normal 1 Free
~) Normal+insert @ Lock pads
) Virtual I Lock Footprint
Auto Place
Rotate 90 degrees Rotate 180 degrees
0 0
0 10 0 10

Local Settings

Pad connection to zones: | Use zone setting 2

Set clearances to 0 to use global values

Pad clearance: v] mm
Solder mask clearance: 0 mm
Solder paste clearance: -0 mm

Solder paste ratio clearance: |-0,000000 %

Cancelar | [Aceptar |

Una vez aqui, vamos a borrar todas las lineas menos la exterior situada en la capa F.Silks

(Silks de la capa TOP)
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Ademas, también vamos a borrar tanto el nombre del componente como la referencia, para
ello, situamos el raton encima del texto y pulsamos la tecla “E”. En el menu desplegable que
saldra, solo tenemos que seleccionar la opcién “invisible” en la seccion “Display”.

Footprint Text Properties

Footprint D8 (LED) orientation 0,0
Reference; D8 S}y[e
@® Normal
Width (mm): 1 Italic
Height (mm): 1 Orientation
Thickness (mm): |0,15 @ Horizontal
) Vertical
Offset X (mm): 1,27
& : Display
OffsetY (mm): |-3,96 Visible
Layer: BF.silks > | @ |invisible
Cancelar | | Acepkar |

L oll!
Para finalizar, vamos a seleccionar “Update footprint in current board” = y saldremos del
editor sin guardar los cambios.

Repetiremos la misma operacion con el resto de componentes.
Para la red de resistencias, vamos a borrar toda la parte grafica ademas del nombre y la

referencia. Y lo mismo con el conector.
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Cuando tenemos la placa limpia de elementos que no necesitamos, vamos a crear el silk. Para
crearlo existen varias opciones:

- Utilizando la herramienta de texto del PCBNew . Esta opcion permite también
afiadir texto a en las capas de cobre, pero tiene varias limitaciones. Algunas de ellas
son: El tipo de letra es por defecto, el texto en las capas de cobre queda delimitado por
cuadrados...

- Crear un componente con el silk o el texto que queremos afiadir de la misma forma que
hicimos con la forma de la placa.

En nuestro caso, vamos a crear el silk y un pequeno texto en la capa de cobre para ponerlo
como numero de serie utilizando la segunda forma. Para ello, lo primero que vamos a hacer es
exportar el PCB en formato SVG. File->Export SVG.
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I'a Export SVG Ffile

Output directory:

i /home/_jose__/Escritorio/tutorial/silks/ Browse...
2 L
LC?:;:[ Layers:  Technical Layers: PD[é?;EI\:Gp;\p's;:gg?mm) F_ile SJLnE
& F.cu Ol =i i o - One file per layer
& e.cu [ EAdhes ErnEmGde @ Allin one file
["] B.Paste @® color ! Plot ‘
] F.Paste () Black and white
[ Bsilks SVG Page Size Elose
& Fsilks ) Full page with frame ref
& B.Mask () current page size
[ F.Mask @® Board area only
[ bwgs.User B Print board edges
L Jicmz=Deer [ Print mirrored
[_] Ecol.User
[] Eco2.User
[ Edge.Cuts
& Margin
["] B.Crtyd
[] F.Crtyd
["] B.Fab
[ F.Fab
Messages:
Plot. Ylhomefjose/Esc ritorioftutorialisiks/sik/tra_LEDS brd svg' OK.
Plot: ‘fhomefjose/Escritorioftutorial/silks/tira_LEDs-brd.svg' OK.
1 Filter: & All C : Save report to file...

A continuacion, vamos a modificar el archivo SVG generado, afiadiendo el nimero
correspondiente a cada LED en el conector, y a que pin corresponde el GND.

OO

. OOO0OOH 0000NR .
GND GND
GND1 2 3 45 67 8

Una vez lo tengamos, vamos a quedarnos solo con el texto que hemos anadido, lo convertimos
a trayecto, de la misma forma que lo hicimos cuando creamos el borde de placa y lo vamos a
situar en una capa llamada “SilkS” y generamos el componente utilizando el script.

GND GND 21| Eigesi
GND1 2 3 4 5 6 7 8
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De la misma forma, vamos a crear un componente que sea un texto en la capa de cobre. Para
ello, vamos a crear en Inkscape el texto “abierto.cc” y lo vamos a situar en una capa llamada

‘Cu”.

abierto.cc

Una vez los hayamos creado, los importamos a PCBNew y los afiadimos a la placa.

ReslstorArray

G
A 3 3 ks

Al crear el componente sobre la capa de cobre obtenemos el siguiente resultado:

Donde podemos observar que el plano se ajusta al texto.
El resultado final de la placa es:

HOOOOOOO

GND GND

GND1 2 3 45 6 7 8
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Archivos Gerber

Los archivos Gerber son los archivos que el fabricante de PCB necesita para fabricarlo. Antes
de generarlos, vamos a crear una carpeta en la carpeta contenedora de nuestro proyecto, de
nombre “gerber”.

A continuacion vamos a File -> Plot.

En la ventana que se nos abre vamos a seleccionar las siguientes opciones:

Plot formak: Output directong

[Geber =] gerbes [ Browe-. ]
Layers Options
[ F.cu | 7] Piot sheet reference on all layers Drill markcs:
¥ B.Cu | Ptet pads en silksereen Mane
B.Adhes | Plot footprint values Sealing:
| FAdhes o | Piot foctprink references
[T B.Paste | Force plotting of invisible valuss/references
| E.Paste | Do not tenk vias Flot mode
il BSilkes | Exclude PCE edge layer from other Layers Filled
ks hflese s ol Default fine width (")
o= egatree plot
4] F.Mask el
[T Drwgs.Uzer
| Cratelizar Current solder mazk settings:

[7] Ecal User Solder mask clearance: 0003037007874 *

. .I:ul.lJ::r Salder matk rman wedth: 0°
| Edge.Cuts

L Margin Gerber Options

] B.Crivd

: F.CnYd | Use Protel filename extensions

[] B.Fab | Include extended sttabutes 4.5 fust. mam)
AF.Feb | Subtract soldermask from silkscreen ) 4.6 (unit mm)

1

] Use ausiliary axis a5 origin

Format

Messages:

Plot file CI:t".Wnrhpan:e‘\.KiCad‘l.prnj‘.ESF‘-hﬂknl.rﬁg:rb:r‘.ESP-hﬂknu‘t-F_Cu.gll* created
Mot file « D\Warkspace\KiCad\ pre\ ESP-Breakout \gerber ESP- Breakaut-B_Cu.gbl> crested
Plot file < \Workspace\KiCadprof ESP - Breakouth gerber ESP - Breakout-B_Sik5.gbo» created
Plot file <E:\qukspa::".lﬁiCad".prpj'.l:'SF‘-ﬂfﬂlcnuﬂg:rb:r".ﬁP-mkqu‘t-F_Silks..g'm: created
Mot file < D\Warkspace\KiCad\ pre\ ESP-Breakout  gerber ESP- Breakaut-B_Mazk.gbs> created
Plot file < D\Workspace\EiCad\prof\ESP- Breakouth gerber ESP- Breakout-F_Mask.gts> created
Plet file < \Warkspace\KiCadh proj\ESP - Breakout i gerber ESP - Breakout-Edge_Cuts.gbr=
created

[ Generate Diil File | Clase |

Cuando tengamos esta configuracion pulsamos “Plot”, con esto se generaran los archivos
correspondientes a las capas de cobre y silks. Solo nos queda generar el archivo con los
taladros. Para generarlo, pulsamos la opcion “Generate Drill File” y configuramos la ventana
que se abre de la siguiente manera.
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Drill Files 1
Qutput directony:
Browse
Drrill Umits: Drill Map File Format: Info:
() Millimeters | HPGL Default Vias Drill: Drill File
@ Inches @ PostScript Use Netclasses values —
") Gerber l—.M!P Eile

Zeros Format Micro Vias Drill:

= FEAE B Report File
(2) Decimal format 1 5VG letclasses valu J

(7) Suppress leading zeros ") PDF e Canne Close .
(@ Suppress trailing zeros
B e Drill File Options: Plated Pads: 10
= P [~ Mitror y axis Mot Plated Pads: 0
Precision [~ Minimal header Through Vias: 53
24 [¥] Merge PTH and NPTH holes into one file Micre Vias: 0
Buried \ias: 0

Drill Qrigin:

*) Absolute

@ Awdliary axis
Messages:

Cuando tengamos la configuracion adecuada, presionamos Drill File y generaremos el archivo
de taladros que necesitamos.

Este es el ultimo paso a realizar para fabricar nuestra placa PCB, mandando los archivos

Gerber que acabamos de generar al fabricante, éste tiene todo lo necesario para faricar el
PCB.

En el programa GerbView, podemos comprobar que los archivos Gerber han sido bien
generados.

iEnhorabuena!

Ya has fabricado tu propio PCB.

Sujeto a la licencia Reconocimiento-NoComercial-Compartirlgual 4.0 Internacional de Creative Commons



https://creativecommons.org/licenses/by-sa/4.0/

